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July 2011

Vol 36 No 7

Main Meeting, July 10
NOCCC election results. (See page 4)
Big prizes (such as a D-Link Wireless N 150 Home Router) for our July raffles (See page 5)
June raffle winners’ pix (Page 18,19)
We will not have a Consignment Table or E-Waste Collection during the July 2011 meeting. (See page 6)

Special Interest Group (SIG) & Main Meeting
9:00 a.m.

10:30 a.m.

Linux for Desktop Users ............................ Science 131
Topics about the Linux operating system. Beginner’s Qs here.

Advanced Digital Photography .................Science 127
How to match colors with precision.

Visual Programming .................................... Science 111
Visual Basic, Visual BasicScript, Visual C++ and Visual J++.
Microsoft Word, Excel, and Outlook ......... Science 109
Topics about these three parts of the Microsoft Office Suite.

Understanding Operating Systems .......... Science 111
Help with DOS, Windows, OS/2, etc.
Mobile Computing .....................................Science 109
This new SIG discusses mobile devices.

Beginners Digital Photography ................. Science 127
Topics about digital photography.

12:00 Noon

Reviews & Consignment Tables, Coffee & Donuts: Irvine Hall lobby

PIG SIG ......................................... Hashinger Courtyard

10:30 a.m.

Microsoft Access ....................................... Science 306
Database applications and more.

Beginners PC Q & A .....................................Irvine Hall
Beginners’ questions about PCs.

12:30 p.m.

Linux Administration .................................. Science 131
More topics about the Linux operating system

Advanced PC Q & A....................................... Irvine Hall
PC hardware & software topics.

.

Access/Excel VBA ...................................... Science 306
Access & Excel VBA code

NOCC website:
http://www.noccc.org
* SWUG 1st Prize in 2004, 2005, 2006

2:00 p.m. Main Meeting ....... Irvine Hall

Future Meeting Dates in 2011:
July 10, August 7,Sept 4,Oct 2,Nov 6,Dec 4
APCUG 2nd Prize in 2003,2004, 2005

Founded April 1976
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Orange Bytes Staff
Publication Chairman Oversees publication tasks and converts the
Orange Bytes newsletter to PDF for printing and web posting; transmits
PDF to Printer.
Ted Littman

(714) 779-1936

tedlit@roadrunner.com

Editor Edits and makes final selections of the articles to be included in

the newsletter.
Ted Littman

editor@noccc.org

Associate Editor/Production Receives articles from the editor and
lays out the issue of the newsletter.
Tony Loechner (949) 574-4886

tonyL@Loechner.com

Circulation - Oversees mailing and distribution of the newsletter.
Richard Miller

(714) 309-1504

rrrmil@gmail.com

Reviews Editor - Communicates with the vendors and members who
evaluate products and write reviews. Makes sure members meet deadlines. Sends a copy of the newsletter to vendors of products we review.
Ted Littman
(714) 779-1936
reviews@noccc.org
Copy Editor - Does final proof reading of the newsletter for typos and
misspellings.
Dennis Martin…………….(951) 926-3065 dennismartin@dslextreme.com

VOLUNTEERS NEEDED
The following positions are available:
Social Media Contacts – Maintain and write articles for the newsletter.
Contributing Editors Write articles for the newsletter.
Commercial Advertising - Obtains ads from vendors for the newsletter.
Classified Advertising - Obtains computer-related, non commercial ads
for the newsletter free to NOCCC members.
Contact editor@noccc.org or (714) 779-1936.

Celebrating 35 years of
“Friends Helping
Friends”
Orange Bytes

July 10th Main Meeting
2 p.m. Irvine Hall.
Jim and other BOD members are working to obtain a
speaker for the July meeting. Unfortunately, we have to go
to press for the print version of our newsletter before the
specifics are available. We will let you know by email.

President’s Message
By Jim Sanders, NOCCC President
There is a lot of buzz in the news right
now about who will be the Republican
candidate for president in 2012. Has a
candidate made a trip to Iowa or New
Hampshire? What kind of groups did
he/she speak at and what was the topic
of the speech. Has a political action
committee been formed? How much
money is in his/her war chest? Has the
candidate made any verbal gaffes? Is
there any embarrassing baggage that
someone somewhere has dug up out
of the dirt? Has he actually declared his candidacy? What do
the political gurus think of his chances? And the list goes on. In
NOCCC elections, life is much simpler. If you are even willing
to have your name be on the ballot, you are elected by default.
The last time a ballot was needed, was when you were asked to
decide if you were happy with Herb Wong’s reign as President of
the club, or preferred the agenda that I proposed. Since that time,
a ballot has not been needed because we were lucky if we could
find volunteers to fill the slate. At this last election, not even that
goal was achieved as nobody volunteered to run for the position
of VP. Even with the enticement the Asus Netbook computer for
the Members Only prize drawing, and a good speaker, we had a
whole 40 members show up for the Main meeting and election.
That is not a number that I am impressed with, and makes me
wonder how many people really care.
The only new name on this year’s slate was new member Dr.
Patricia Adelekan. Her enthusiasm for the valuable resource that
the club represents has been very refreshing. If you care to review
who is currently running the club, the list is usually on page 6
of the Bytes under the heading of Officers. That list includes all
of the special functions that volunteers are needed for, and you
should note that several people are doing double and triple duty.
On a different topic, the 10:30 AM beginners PC Q&A Special
Interest Group that I have been leading does not seem to be of
much interest as there are seldom more than two people in attendance. I have decided that a better use of my time would be
on a different subject. So starting in July we are going to have a
number of sessions in that time-frame devoted to building a new
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computer. The initial concept is to pick three price points,
$500, $750, and $1000 for the cost of goods to build a new
computer. Members who are contemplating building a new
computer will bring in their list of parts that they think would
be appropriate at different price points. Everybody present
will then debate the merits of those choices with real-time
research on the Internet to compare prices and features of different offerings. At the first meeting, a good deal of time will
be spent defining how we will go about this in general terms.
Ultimately, if a member decides to build one of the categories
of machines and buys all the parts, we will put it together at
the meeting. ‘Till next month.

Preparing a Review or Article for
the NOCCC Orange Bytes
By Steven Breitbart, NOCCC
There are two sections in the NOCCC newsletter, the Orange
Bytes, where our members can contribute reviews and articles.
They are the Computer Talk section and the Product Reviews section.
Articles in the Computer Talk section can be about almost any
computer or technology related experience that you have had.
For example, getting a new ISP, getting an ISP to change your
connection speed, converting a PC to Linux, using a MacIntosh
PC for the first time - the list is endless.
The Product Reviews section can be a review of almost any type
of computer hardware, software, or book about a computer- related topic. The item can be something you have bought or
obtained from the NOCCC. Once you agree to do a review, you
will generally have 2 months to complete it. These reviews are
published in this newsletter, the Orange Bytes.
The NOCCC Reviews Editor, Ted Littman, (714) 779-1936, reviews@noccc.org is regularly sent copies of books and software
by the publishers for review by our members. We need NOCCC
members to take these items and commit to reviewing them
promptly. The reward for doing a review is that you get to keep
the book or software. If we do not review them, they may stop
sending these items in the future.
Important! There are two articles at the following link. One
provides suggestions and guidelines for preparing a review or
article for the Orange Bytes. The second provides guidelines for
submittal. Please read both. The link is: www.noccc.org/bytes/
info/index.html
The NOCCC reserves the right to refuse to publish any article or
review at the discretion of the editors of the Orange Bytes newsletter or officers of the club. Reasons may include, but are not
limited to, length and quality of the review or offensive nature of
the product or of the review.
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NOCCC Elections at the
June 2011 Main Meeting
Please consider becoming more involved in running the
NOCCC. During the June 2011 meeting, we held our annual
elections. One position on the NOCCC Executive Board was
not filled since no one volunteered for the position of Vice
President. While mostly taken from the Bylaws, the summary
below is not all-inclusive.

property to be permanently identified as property
of the NOCCC.

Duties of the Treasurer include:
•
•
•
•

NOCCC Executive Board

Receive and deposit into the NOCCC accounts all moneys
received.
Establish and maintain an accurate journal of all receipts
and disbursements of NOCCC money.
Report at the regular general meetings a summary of the
financial status of the NOCCC.
Suggest, if appropriate, to the Executive Board that an
audit be made and reported to the general membership.

The NOCCC Executive Board “subject to the limitations of
those bylaws, shall debate, establish, amend, and update the
policies for all the affairs and business of the NOCCC.”

Elected Directors

“The Board shall concern itself with the disbursement of all
NOCCC moneys. The Board shall consider the budget and
such additional expenditure requests as are submitted by the
president, and shall authorize such expenditures as it considers
wise and appropriate.”

Ex-officio members of the Executive Board

The NOCCC Executive Board consists of four officers, eight
elected directors, and ex-officio members. There are four
officers of the club: President, Vice-President, Secretary, and
Treasurer.

Duties of the President include:
•

Represent the NOCCC to the community as the chief
executive officer.
Set the agenda for and presides at all general meetings of
the club.
Set the agenda for and presides at all meetings of the
NOCCC Executive Board.
Appoint members to chair all standing and special committees and appointed positions.
Receive, on behalf of the NOCCC, all contributions to the
club.

•
•
•
•

Duties of the Vice-President include:
•

Assume the duties of the president in the president's
absence.
Assume special duties as may be directed by the president.

•

Duties of the Secretary include:
•

Establish and maintain a record of all NOCCC correspondence, and attend to correspondence as directed by the
president or the Executive Board.
Establish and maintain records of the proceedings of all
regular and special general meetings, and of the Executive
Board meetings.
Establish and maintain a record of all real or personal
property acquired by the NOCCC and cause said

•
•
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The eight elected directors are on the Executive Board and,
along with the four officers, address any issue that comes
before the Board.

Ex-officio members of the Executive Board are the immediate
past president, editor of the club newsletter and the webmaster. The President appoints the editor and webmaster.

Other Appointed Positions
These positions are Membership Chairman, Reviews Editor, Public Relations, Business Solicitations/Lecture Series,
Classified Advertising for Members, Commercial Advertising, Webmaster and Programs/Speakers Coordinator. Contact
the current club President if you are interested in any of these
positions.

•

Officers & Directors Elected
at the June 2011
NOCC Main Meeting
President: Jim Sanders
Vice President: open
Treasurer: John Heenan
Secretary: Ted Littman
Director: Patricia Adelekan
Director: Steven Breitbart
Director: Mary Cornett
Director: Dallas Hazelton
Director: Ben Lochtenbergh
Director: Richard Miller
Director: Gerry Resch
Director: Gordon Strickland, Jr.
Orange Bytes

Membership Benefits
As a valued member, we bring you a section of discounts and offers
as part of the entire “Benefit of Belonging.” (Caveat: we are unable
to endorse these companies, but make these offers available as a
service to our members.)

User Group Offers - Software and Hardware
User Group Relations – You can now order the latest release of Acronis True Image 2011 from Gene Barlow for only $25 (download)
or $25 plus S&H (on a CD). This top-rated backup utility has many
new features and will work with Windows 7. Use the following link
for special pricing for user group members: www.ugr.com/TrueImage.html.
Techsmith - You can get SnagIt 10, an outstanding screen capture
program, and Camtasia Studio 7, to quickly record, edit and publish
multimedia demos and presentations, bundle for $269, an $81 savings: https://store.techsmith.com/government.asp. You can download
SnagIt 10 alone for $42.95.

User Group Offers - Books and Magazines
Pearson Education Products including Prentice Hall Professional,
Addison-Wesley Professional, IBM Press, Exam Cram, Que Publishing, and Cisco Press. Get 35% off list price by purchasing directly
from the publisher combo site: www.informit.com/join. Sign in or
create an account. Enter the membership code “USERGROUP” (all
caps). Select your items and check out. You are required to register
and apply the code once, but you must be logged in to receive the
special pricing.
O’Reilly Books - Get 40% off all books and videos from O’Reilly,
Microsoft Press, Pragmatic Bookshelf, and SitePoint, or 50 % off
books you purchase directly from O’Reilly. Just use code DSUG
when ordering online, www.oreilly.com/store/, or by phone, (800)
998-9938. Free ground shipping on orders $29.95 or more in the US.
If for any reason you are not completely satisfied with your purchase,
you can return it to O’Reilly and get your money back; see www.
oreilly.com/oreilly/cs/guarantee. A return shipping label is included
with every direct purchase and directions are posted online in case
you misplace it.
Peachpit Press Books Discount - Get 35% off by joining the Peachpit Club. Use the following hyperlink to sign up: http://memberservices.informit.com/my_account/login.aspx?partner=52 to sign up as
a member. User group members should note that once you have become a Peachpit Club member, you might use your user group coupon code ON TOP of the permanent savings you earn as a member of
the club. Just log into the site before you make a purchase to ensure
this permanent discount will be in effect, and then enter coupon code
UE 23AA PEUF (case-sensitive) at checkout! This coupon code is
an exclusive offer that may not be used in conjunction with any other
coupon codes. The offer applies to all titles at peachpit.com including New Riders, Macromedia Press, Adobe Press, and Peachpit.
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Free Internet Libraries - Upon retiring from college teaching/
administration, Walter Antoniotti began developing Free Internet
Libraries for students, teachers, and professionals. (http://www.
businessbookmall.com/Free Internet Libraries.htm) Of special
interest to PC users are these free computer libraries:
Free Business Software
(http://www.businessbookmall.com/Free
Business Software Internet Library.htm)
Free Software Tutorials (http://www.
businessbookmall.com/Software Tutorials
Internet Library.htm)
Excel Internet Library (http://www.businessbookmall.com/Microsoft_Excel_Directions_For_Beginners.htm)

THE JULY 2011 CLUB RAFFLES
GENERAL DRAWING PRIZES*:
D-Link Wireless N 150 Home Router
Champion 8-Sheet Cross-Cut Shredder
Digital Multimeter – 19 Ranges
More Gadgets and Surprises!
* Parking stubs are good for two raffle tickets each!
See the article immediately below this list!

MEMBERS-ONLY DRAWING PRIZES:
(Wear your NOCCC Badge and get a free ticket!)
D-Link Wireless N 150 Home Router
Logitech Clear-Chat Premium PC Headset
Digital Multimeter – 19 Ranges
More Gadgets and Surprises!

Save Your Parking Permits!
To offset the cost of parking in the Lastinger Underground Parking Structure, the NOCCC Board approved a motion to give each
member two NOCCC General Drawing raffle tickets in exchange for
the Lastinger-parking permit. Turn the bottom-half “receipt” part of
your permit to the Rafflemeister on the same day or hold it until the
next meeting. Gerry Resch, the Raffle Leader, will exchange it
for two raffle tickets.
The reason for this is that the NOCCC Board has found that some
people are not attending meetings or not renewing their memberships
because of the parking situation. Chapman University has allowed
us to park in the Lastinger Parking Structure under Wilson Field for
only $2 for the whole day of our meeting; normally $2 is good for
only two hours. The advantages of parking there are clear; you don’t
have to drive around looking for a legal spot (remember, don’t park
on the private home side of the street), the car doesn’t get hot and
you don’t have to parallel park. There is even an elevator available
to get down to the parking area.
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Consignment

NOCCC Officers
The area code for the following phone numbers is 714 unless noted.

The NOCCC Consignment Table in the lobby of
Irvine Hall will not be available during the July
2011 meeting. It is open on even months, the
same as the e-Waste collection.
For your information:
1. Only current members can place items for
sale, but non-members are welcome to purchase items from the table. This is a great
place to get some money for your surplus
computer items, and help the NOCCC at the
same time.
2. The consignment table operates on a 90/10%
basis — with the owner getting 90%, and
the Club treasury 10%.
3. You can fill out a Consignment Table User
List
tagseach
at the
Theand
useritem
list and
tagtable:
must contain:
a) Seller’s name
b) Seller’s NOCCC membership number
c) Item name and description
d) Item asking price
4.

The seller may pick up all items and/or
money at any time, but no later than 2 p.m.
on the day of sale. Any items and/or money
not picked up by 2 p.m. will become the
property of NOCCC and will be subject to
disposal at the Club’s discretion. The club
has no storage room available for unsold
items
NOCCC is NOT RESPONSIBLE in any
way for items bought and/or sold at the Consignment Table. Each item is placed and
sold on an AS-IS BASIS.

5.

E-Waste Collection
California disposal laws have made it illegal
to put monitors and computers in the regular
trash. Omni Technics, Inc. will be at our
regular meetings to collect E-Waste on even
months, so save your “junk” ‘till August..
Check their web site for more information:
http://www.ca-recycle.com/.
Or call (562) 627-1910.

President
Jim Sanders ..................................544-3589 .................... president@noccc.org
Vice President
Open
Secretary
Ted Littman ...................................779-1936 .................... secretary@noccc.org
Treasurer
John Heenan ................................. 998-7660......................treasurer@noccc.org
Directors
Dr. Patricia Adelekan ...................................................p_adelekan@yahoo.com
Steven Breitbart ........................... 486-3070.................sbreitbart@socal.rr.com
Mary Cornett.................. (949) 716-0779.......... pacificblu.mary@gmail.com
Dallas Hazleton. ........................... 526-1592........ ghazleton4@dslextreme.com
Ben Lochtenbergh…….......(949) 653-2545 ................................ bal@msn.com
Richard Miller .............................. 309-1504......................... rrrmil@gmail.com
Gerry Resch ................................. 772-6667.................. gerry@gerryresch.com
Gordon E. Strickland, Jr............... 970-7730. ..........gestrickland@earthlink.net
Editor
Ted Littman .................................. 779-1936...........................editor@noccc.org
Webmaster
Jim Sanders, Acting ..................... 544-3589..................... president@noccc.org
Volunteers, Committees, and Projects
Consignment Table
Richard Miller .............................. 309-1504......................... rrrmil@gmail.com
Raffle Leader
Gerry Resch ................................ 772-6667 ................. gerry@gerryresch.com
Helpline
Ted Littman .................................. 779-1936.................. tedlit@roadrunner.com
Membership Database
John Heenan ................................. 998-7660 .....................treasurer@noccc.org
Membership Chairman
Ben Lochtenbergh................(949) 653-2545 ............................... bal@msn.com
SIG Coordinator
Dallas Hazleton ........................... 526-1592........ ghazleton4@dslextreme.com
Programs/Speakers Coordinator
Mary Cornett…………........(949) 716-0779 ........ pacificblu.mary@gmail.com
Public Relations.
Mary Cornett……................(949) 716-0779 ........ pacificblu.mary@gmail.com
University Liaison
Jim Sanders .................................. 544-3589..................... president@noccc.org
Chapman U. Campus Security ....... 997-6763......... open locked rooms, problems

NOCCC is a Member
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NOCCC Help Volunteers
The Help Line is in the true spirit of the NOCCC, which is to help others to learn more about computers. The following is a list of
Help Line subjects that a NOCCC volunteer is able to help you deal with. Call (714) 779 1936 or e-mail Ted Littman at helpline@
noccc.org with additions, deletions, or corrections. Most volunteers prefer being contacted by e-mail. Mention NOCCC in the
Subject line.
Apple II ...............................Gerry Resch
714-772-6667
Computer Boards ...............Martin LaRocque 562-697-4318
Corel Draw..........................Larry Klees
714-879-7962
Digital Photography ............Larry Klees
714-879-7962
Excel ..................................Gerry Resch
714-772-6667
GPS Navigation ..................Bob DeWolf
714-879-8269
Linux ...................................Bob Ray
714-634-7520
Lotus 1-2-3 .........................Gerry Resch
714-772-6667
Memory/Interrupts ..............Martin LaRocque 562-697-4318
Microsoft Office...................John Heenan
714-998-7660
PC Hardware ......................Jim Sanders
714-544-3589
Photo editing & Pshop ........Larry Klees
714-879-7962
QuickBooks - all ver. ...........Linda Russell
909-949-4930
Tcl/Tk & UNIX .....................Bob DeWolf
714-879-8269
Windows 7, Vista & XP .......Jim Sanders
714-544-3589
Windows 9X & XP ..............John Heenan
714-998-7660
WiFi & Networking ..............Jim Sanders
714-544-3589

..................... gerry@gerryresch.com
...........................................6 - 9 p.m.
..................... larryklees@yahoo.com
..................... larryklees@yahoo.com
..................... gerry@gerryresch.com
..................... rsdewolf@adelphia.net
............. bobsdesk@dialup4less.com
..................... gerry@gerryresch.com
...........................................6 - 9 p.m.
.................. heenanjc@sbcglobal.net
.................jsanders@ligasmicro.com
..................... larryklees@yahoo.com
.......................qbqueen@verizon.net
..................... rsdewolf@adelphia.net
.................jsanders@ligasmicro.com
.................. heenanjc@sbcglobal.net
.................jsanders@ligasmicro.com

The names of our
volunteers are only
available in the
printed version of the
Orange Bytes.

Do you want to be an NOCCC Help Volunteer and assist other members with computing subjects that you know
well? If so, please contact Ted Littman at tedlit@roadrunner.com or (714) 779-1936.

SIG Leaders
Contact the SIG leaders by e-mail, preferably, rather than by telephone.
SIG ............................................... BLDG ......RM.
......................................................
Linux for Desktop/Admin ............Science .....131
Beginner’s Digital Photography ..Science .....127
Visual Programming ....................Science .....111
Word, Excel and Outlook .............Science .....109
Access/Excel VBA.......................Science .....306
Advanced Digital Photography ....Science .....127
Understanding OS’s .....................Science .....111
Access ..........................................Science .....306
PC Q&A .......................................Irvine Hall

TIME............ LEADER

E-MAIL .......................................................... PHONE

9:00/10:30 .......Bob Ray
9:00 .................John Krill..
9:00 .................Anson Chapman
9:00 .................Tia Christian
10:30 ...............Bob Dickson
10:30 ...............Larry Klees
10:30 ...............Charlie Moore
12:00 ...............Bob Dickson
10:30/12:30 .....Jim Sanders

bobrobo@dialup4less.com
noccc.bgphotosig@gmail.com
aeccrcss@hotmail.com
lwilliams_00@yahoo.com
robertbdickson@socal.rr.com
larryklees@yahoo.com
mooreca@roadrunner.com
robertbdickson@socal.rr.com
jsanders@ligasmicro.com

(714) 634-7520
(949) 497-8658
(909) 860-9515
(714) 263-6105
(714) 539-1304
(714) 879-7962
(714) 529-9071
(714) 539-1304
(714) 544-3589

Please report SIG changes to Ted Littman, editor@noccc.org, or (714) 779-1936.
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Computer Talk
Word Tips
Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Word tips can be found online at
http://word.tips.net.

Creating a Table of Contents
from Heading Levels
If you are writing a long document or a book, you may want to
create a Table of Contents (TOC) for your document. The easiest
way to create a TOC is to use heading levels, as defined by the
Word styles. To do this, follow these steps:
1.
Position the insertion point where you want the TOC
inserted.
2.
Choose Index and Tables from the Insert menu. (In Word
2002 or Word 2003, choose Reference from the Insert menu, then
choose Index and Tables.) Word displays the Index and Tables
dialog box.
3.
Make sure the Table of Contents tab is selected. If you
are using Word 97, choose From Template in the Formats list. In
later versions of Word, make sure the Formats drop-down list at
the bottom of the dialog box is set to From Template.
4.
Using the Show Levels control, specify how many heading levels should be included in the TOC.
5.
Click on OK.

5.
Make sure that the Formats drop-down list is set to From
Template.
6.
Using the Show Levels control, specify how many heading levels should be included in the TOC.
7.
Click on OK.

Changing Styles
Once you have defined a style in Word, you can change it at any
time. To do this, follow these steps if you are using Word 2002 or
Word 2003:
1.
Choose Styles and Formatting from the Format menu.
Word displays the Styles and Formatting pane.
2.
In the Pick Formatting to Apply List, locate the style you
want to change and simply point to it. (Don't click on it.) Word
displays a down-arrow at the right side of the style name.
3.
Click on the down-arrow. Word displays a drop-down

If you are using Word 2007, then the steps are a bit different:
1.
Position the insertion point where you want the TOC
inserted.
2.
Display the References tab of the ribbon.
3.
Click Table of Contents in the Table of Contents group.
Word displays a drop-down list of TOC options.
4.
Choose Insert Table of Contents. Word displays the
Table of Contents tab of the Table of Contents dialog box.

menu.
4.
Click on Modify. Word displays the Modify Style dialog
box
5.
Change the attributes of the style, as desired. You may
need to use the Format button to make your changes.
6.
When completed, click on OK.
7.
To change other styles, repeat steps 2 through 6.
continued on Page 9
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Word Tips continued from Page 8

8.
When you are done changing styles, close the Styles and
Formatting pane.
If you are using Word 97 or Word 2000, the process is a bit different. Follow these steps to change a style:
1.
Select Style from the Format menu. Word displays the
Style dialog box.
2.
In the Styles list, select the style you want to change.
3.
Click on Modify. Word displays Modify Style dialog
box opens.
4.
Change the attributes of the style, as desired. You may
need to use the Format button to make your changes.
5.
When completed, click on OK. The Cancel button
changes to Close.
6.
To change other styles, repeat steps 2 through 5.
7.
When you are done changing styles, click on Close.

Resetting Word Menus
Word makes it easy to customize virtually everything you see on
your screen. It is possible, for instance, to change the options that
appear on the menus used by Word. If you run across a system in
which the menus have been changed, then you can change them
back by following these steps:
1.
Choose the Customize option from the Tools menu.
Word displays the Customize dialog box.

2.
With the Customize dialog box still open, right-click on
the actual menu that you want to reset. (Click on the actual menu
at the top of the program Window, not within the dialog box.)
Word displays a Context menu. If you only want to reset a submenu, left click on the major menu and then right-click on the
sub-menu.
3.
Choose Reset from the Context menu. The menu options
are returned to their default settings.
4.
Close the Customize dialog box.
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Controlling Where a Full-page Border
is Printed
In other issues of WordTips you learn how you can add a fullpage border to a document. Using full-page borders can cause
some problems, however. For instance, when you print out your
document, you may discover that one (or more) of the sides of
your border don’t print out.
If you encounter this problem, the reason is because Word is trying to place the page border in an area that your printer considers
a non-printable area. With very few exceptions, printers have
non-printing areas around the edges of a piece of paper. Nonprinting areas on the left and right of the page occur because the
printer has to “grip” the paper somewhere, and in those areas
where it is being gripped, the printer can’t print. Non-printing
areas on the top and bottom of a page occur because the printer
cannot maintain accurate control of the page as it first enters the
printing area or just leaves it.
If you want to adjust where a full-page border is printed on a
page, follow these steps:
1.
Choose Borders and Shading from the Format menu.
Word displays the Borders and Shading dialog box.
2.
Make sure the Page Border tab is selected.

3.
Use the controls in the dialog box to specify how you
want the border to appear.
4.
Click on the Options button. Word displays the Border
and Shading Options dialog box.
5.
Use the Measure From drop-down list to specify whether your measurements are going to be calculated from the edge of
the paper or from the text on the page.
6.
Use the controls in the dialog box to specify where on
the page the border edges should be printed.
7.
Click on OK to close the dialog box.
8.
Click on OK to close the Borders and Shading dialog
box.
continued on Page 10
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Word Tips continued from Page 9

Excel Tips
Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Excel tips can be found online at
http://excel.tips.net.

Adding Pop-Up Documentation
to a Cell

Want a neat trick you can use to make your worksheets
more helpful to users? How about adding a pop-up window
that displays documentation whenever the cell is selected?
To add such a feature, follow these steps if you are using a
version of Excel prior to Excel 2007:
1.
Select the cell for which you want the pop-up to
appear.
2.
Choose Validation from the Data menu.

There are a few things to keep in mind as you specify
where you want your full-page borders printed. When
specifying the location of the borders in step 6, you can
specify any value between 0 points and 31 points. This
means that the maximum distance for the borders is 31/72
of an inch, or less than half an inch from the paper’s edge if
you specify that borders are calculated Edge of Page (step
5). If your printer cannot print within the last half inch of
the paper, for instance, you won’t see the bottom edge of
the full-page borders.
To get around this, try changing the way the border is
calculated so it is Text (step 5) and then play with different
positioning settings. This may take a bit of trial and error.
If you still can’t get just the results you like, then you can
forego using a full-page border and simply place a large
rectangle AutoShape (with no fill) on your page. You then
have full control over where the sides of the rectangle are
printed.
If you would like more information on full-page borders
and why they may not print, check out this page at the
Word MVP site:
http://word.mvps.org/FAQs/Formatting/BottomsDontPrint.
htm
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3.
Make sure the Input Message tab is displayed.
Make sure the Show Input Message When Cell is Selected
check box is selected.
4.
In the Title box, enter a title for the pop-up window. (This title appears in bold at the top of the pop-up
window.)
5.
In the Input Message box, enter the text of the
documentation you want to appear in the pop-up window.
6.
Click OK.
If you are using Excel 2007 then you should follow these
steps:
1.
Select the cell for which you want the pop-up to
appear.
2.
Display the Data tab of the ribbon.
continued on Page 11
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Excel Tips continued from Page 10
3.
In the Data Tools group, click the Data Validation tool.
Excel displays the Data Validation dialog box.
4.
Make sure the Input Message tab is displayed.
5.
Make sure the Show Input Message When Cell is Selected check box is selected.
6.
In the Title box, enter a title for the pop-up window.
(This title appears in bold at the top of the pop-up window.)
7.
In the Input Message box, enter the text of the documentation you want to appear in the pop-up window.
8.
Click OK.
There are, obviously, other ways you can use the Data Validation feature of Excel to check and limit the data that is entered
in a cell. However, if you follow the steps above, all data is still
accepted, and Excel displays a helpful message whenever the cell
is selected.

Quickly Selecting Cells

myLink = “path/filename.pdf”
TargetPage = 7 ‘Page number to be shown
With objIE
.Navigate myLink & “#page=” & TargetPage
.Visible = True
End With
End Sub
The code could also be rather easily changed to a function to
which you can pass the desired path and target page.

Single-Use Drop-Down List
One of the really cool uses for the data validation feature in Excel
is the ability to create a single-use drop-down list. This list allows
users to select the cell and then select from a list of pre-defined
values for that cell. Once the user makes a selection and moves to
a different cell, the arrow for the drop-down list disappears.

You already know that you can use the mouse to select a range
of cells by holding down the left mouse button and dragging the
mouse to make a selection. There is an even quicker way to select
cells using the mouse, however. This is done in the following
manner:

Start by creating a list of the values that you want available in
the drop-down list. You can create this list almost anywhere, but
for design purposes it is a good idea to put the list on a different
worksheet than the one where the data entry will be.

1.
Select the cell that marks one corner of the range of cells
you want to select.
2.
Move the mouse pointer so it points to the cell at the opposite diagonal corner of the range you want selected.
3.
Hold down the Shift key as you click once on the left
mouse.

For example, let’s say that you want a list of employee names.
On a new worksheet, enter the employee names in any manner
desired. (You probably will want to sort them in some manner.)
Select the list and give it a name such as Employees. (To define a
name use Insert | Name | Define.) Now, back on the main worksheet, follow these steps:

Linking to a Specific Page in a PDF File

1.
Select the cell where you want the drop-down list to appear.
2.
Choose Validation from the Data menu. Excel displays
the Data Validation dialog box, with the Settings tab visible.
3.
Using the Allow drop-down list, choose List.
4.
Make sure the In-Cell Dropdown check box is selected.
5.
In the Source box, enter =Employees. (This is the name
you earlier gave to the employee list.) Don’t forget the equal sign;
it is very important.
6.
Click OK.

Gary wants to link from an Excel worksheet to a specific page
in a PDF file. He can get Excel to link to the PDF but it starts
on the first page of the PDF, not the page he wants. Gary believes that Excel is ignoring the PDF command that tells it
the page he wants. As an example, he can use the formula
=HYPERLINK(“E:\\test\gary.pdf#5”) and Excel ignores the #5
part and opens to the first page of the PDF.
This does, indeed, seem to be the case, Gary. The HYPERLINK
worksheet function seems to ignore the page specification for
some strange reason. There also doesn’t seem to be a way around
this problem with the function.
Fortunately, you can use a macro to do the opening, if you desire.
The following macro relies upon Internet Explorer to open the
PDF and display the proper page:
Sub OpenPDFpage()
Dim myLink As String
Dim TargetPage As Double
Dim objIE As New InternetExplorer
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Now, whenever someone selects the cell you used in step 1,
they’ll see a drop-down list arrow to the right of the cell. Clicking
on the list provides a drop-down listing all the employees. The
user can select one of the employees, but cannot enter a different name. When they move to a different cell, the drop-down list
disappears, but the selected value remains visible.
As a side note, if you don’t want to place your data list in a
worksheet, then you can enter the choices directly into the Data
Validation dialog box. In step 5 (the Source box), leave out the
continued on Page 12
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Excel Tips continued from Page 11
equal sign and just enter the choices. Separate them by commas,
and those are the choices that will be available to the user.

Creating New Windows
If you want to work on two different parts of the same workbook
at the same time, there are a couple of different ways you can do
so. One way is to open a second window. You do this by simply
choosing New Window from the Window menu or, in Excel
2007, displaying the View tab of the ribbon and clicking New
Window in the Window group. Excel opens a new window. You
can then use each window to display and edit different parts of
the same workbook.
Notice that each new window you create has not only the
workbook name in the title bar, but also a number that indicates
the actual window number. Thus, you could have Book1:1 and
Book1:2. These are the same way that the window names appear
at the bottom of the Window menu (or on the Switch Windows
drop-down list of the ribbon’s View tab in Excel 2007) and on the
Task bar.
Each window created in this way just provides a different way
to look at the exact same workbook. This means that any change
you make in one window is automatically and immediately made
in the other window as well.

Construction at Chapman

Construction is being done on Argyros Hall and the some paths
near it, including some from the Lastinger Parking Structure, may
be blocked. Be careful; Sunday is a workday for the construction
crew; in May, a large crane was lifting things to the upper floors.
More information is available at the Chapman web site www.
chapman.edu/about/community/construction/. This site includes
links to two webcams that show the construction.

Transportation Information
Meeting Information
The NOCCC meetings are held at Chapman University,
in the Hashinger Science Center and Irvine Hall, near the
northwest corner of Center Street and Palm Avenue.

Parking Information
Most of this information is on the back cover. For more information, see www.chapman.edu/map/parking.asp. A map
of the Chapman University campus is also available at www.
chapman.edu/map/map.pdf.

Bus
Several Orange County Transportation Authority (OCTA)
buses service Chapman University. Route 54 runs East and
West on Chapman Ave. The 59 runs North and South on
Glassell Avenue, but doesn’t start early enough for the 9:00
a.m. SIGs. Get the most current information or use a trip
planner at www.octa.net. OCTA also has a Consumer Information Center at (714) 636-7433 (RIDE).

Railroad
Metrolink trains can get you to the NOCCC meeting from
the Inland Empire. There are stops in the cities of Riverside,
Corona, and Anaheim Hills. Parking your vehicle is free at
the train station. (See M on map below.)
On Sundays, Inland Empire Orange County Line train 857
leaves San Bernardino destined for Orange County at 7:30
am. Train 859 leaves at 8:55 am. For the return trip, train
858 leaves nearby Orange Metrolink at 3:55 pm and train
860 leaves at 5:35 pm. The Metrolink station is four-anda-half blocks from Chapman University. For specifics
regarding your trip, check the web site: http://www.metrolinktrains.com or call 1-800-371-5465.

For construction and campus event questions, please call the
Community Hotline at (714) 744-7880.

Orange Bytes in Color and More
at the NOCCC Website.
Webmaster Needed!
By Steven Breitbart, NOCCC

Jim Sanders, the NOCCC President, has been updating the
NOCCC web site. Nevertheless, we urgently need a volunteer to
be the Webmaster. If you can help, contact Jim Sanders at president@noccc.org or (714) 544-3589.
The latest issue of the Orange Bytes is now available in PDF
format, in color and with live internal and external links. There is
no user name or password needed. Older issues also are available. Go to our website: http://www.noccc.org/bytes/index.
html.
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Reviews Editor’s Corner
Products Available for Review
The NOCCC regularly receives copies
of books and software from vendors for
our review. We can also request specific products for you to review. These
reviews are published in this newsletter,
the Orange Bytes. Then, you get to
keep the book or software. If you are
interested in doing a review, please call
or send me an e-mail and provide your
membership number, phone number,
and e-mail address. You can pick up
the product in the lobby of Irvine Hall
between 9 A.M. and Noon at the next
NOCCC meeting.

Ted Littman, (714) 779-1936, reviews@noccc.org.

Note to Reviewers
•
•

•
•

You have 2 months to submit a review. Duecause time extensions must be requested from
the Reviews Editor.
You must leave a security deposit (check, credit
card number, or cash equal to the product’s list
value.), returnable upon our receiving an acceptable review.
If you decide to return the product without
reviewing, there is a $2 penalty after the first
month and a $5 penalty after the second month.
Guidelines for preparing your review are addressed on the next page.

Boxed Programs and CDs

Books continued
Office & Home Programs
New: How to Do Everything – Adobe Acrobat X – How to
create, secure, optimize, & distribute PDFs. From McGraw-Hill.
MSRP=$25.
New: Microsoft Office 2010 All-in-One for Dummies – Get
up to speed on all the applications (Word, Outlook, PowerPoint,
Excel, Access, Publisher, & Common Office Tools). From Wiley.
MSRP=$35.
New: Microsoft Access 2010 Programmer’s Reference – This
1200-page reference book tells you everything you need to know
about the latest Access database program. MSRP=$45.

Digital Photography & Design
New: The Portrait Photography Course – Principles, practices, & techniques. By Mark Jenkison, from Peachpit Press.
MSRP=$40.
New: Professional Portrait Retouching Techniques for Photographers using Photoshop – Learn how the pros do it. By
Scott Kelby, from New Riders. MSRP=$50.
New: Canon PowerShot G12 – From snapshots to great shots by
Jeff Carlson from Peachpit Press. MSRP=$25.
New: The Photoshop Elements 9 Book for Digital Photographers – New Riders book by Scott Kelby & Matt Kloskowski.
MSRP=$50.
New: Adobe Real World Photoshop CS5 for Photographers –
From Peachpit Press, MSRP=$60.

Vipre Antivirus Premium 4 – A high-performance antivirus
+ antispyware software with an integrated firewall. And it isn’t
bloated! From Sunbelt Software. MSRP=$40.

New: Chasing the Light: Improving Your Photography with
Available Light. For photographers of all levels. By Ibarionex
Perello. From New Riders. MSRP=$45.

Norton Internet Security 2011 – Symantec’s premier protection
suite for viruses, spyware, spam. MSRP=$70.

New: Adobe InDesign CS5 Classroon in a Book – The official
training workbook from Adobe Systems. Includes a CD. From
AdobePress. MSRP=$55.

Norton Utilities – Symantec’s PC optimization suite.
MSRP=$50.

Books
Operating Systems

Real World InDesign CS4 – This book covers the waterfront
on Adobe’s new design suite. Authored by Olav Kvorn & David
Blatner, it is published by Peachpit Press. MSRP=$55.

New: Degunking Windows 7 – Get your Windows 7 PC running
quickly & efficiently. From McGraw-Hill MSRP=$25.
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Product Reviews
Photoshop Elements 8 and
Adobe Premiere Elements 8 Review
Review by Jim Sanders, NOCCC

Photoshop Elements 8 and Adobe
Premiere Elements 8 came
bundled in a small box not much
bigger than the dual DVD plastic
holder that it encloses. There is
some documentation in the box.
A twenty page pamphlet, “Getting Started with Adobe Photoshop Elements 8”, a sixteen page
pamphlet, “Getting Started with
Adobe Premiere Elements 8”, a
five page pamphlet “Adobe Premiere Elements 8 Quick Reference Card” and three loose sheets
of advertising. Seven of the 20 pages in the PSE8 pamphlet are
devoted to the “Organizer” and only three to the “Editor.”
The first DVD in the box is the program installation disk for
both programs. On a computer running Win 7, after inserting the
DVD, autoplay brings up an install screen that allows you to pick
which program you want to install and a Read Me link for both.
The Read Me file contains some useful information and should
be read first. I was not happy with one part of the Read Me file. It
contains this statement: Alternatively, a printable version of Help
in Adobe Acrobat PDF format (not all languages are available)
can be downloaded from the Adobe web site at http://www.adobe.
com/go/pse_photoshopelwin8_docu. But that link is now taking
you to an Elements 9 page and after floundering around their site
for a while, I finally Googled the current location of the Help
PDF and downloaded the 27MB file. If you don’t do that, Adobe
expects you to have an active Internet connection to get help.
When you try to run the installed program, the first thing that
pops up is the EULA that states: To continue, you must accept the
End User License Agreement............. which is only 8450 words
long, or the size of a small Novella. I hope I didn’t give away the
rights to my firstborn, but I sure didn’t want take the time to read
the novella. When you start the program the opening window
gives you a choice of going to the Organizer or Editor. If you
have a large number of photos and are not happy with the way
that you currently have them organized, the Organizer provides
an extensive number of methods to help you keep track of your
photos. It will take you a while to learn even most of the features
of the Organizer. I got the impression that Adobe expects you
to forsake any other programs or methods that you have been
using to keep track of your photos and turn your life over to their
program. For quite a few people, that may in fact be a pretty good
choice to make. Once you learn how to use the program, and
do all of the flagging, tagging, naming, and cataloging, you will
probably never misplace another photo.
You can switch from the Organizer to the Editor screen and your
active photo will follow you. Once you are in the main Editor
window you will have a plethora of options to choose from. At
the top right of the screen are three colored buttons to
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choose from; edit, create, and share. All of those have drop- down
menus with multiple choices. The edit choices are Guided, Quick,
and Full. Guided is for the newbie, Quick for the intermediate
or easy edit tasks, and Full allows you to do a very large number
of edits. The main vertical toolbar on the left has 25 different
icons to choose from and 10 of those have expandable submenus
to choose from. Not to mention, the standard drop-down menu
bar at the top of the screen and all of the options that it provides.
There are a number of auto correct features that work well. I
was pleased with how well the Auto Red Eye correction feature
works. If it is not a bright red eye problem, you will have to make
a manual correction, but that is pretty easy. One of the features
that separate the men from the boys in photo editing is layers.
PSE8’s layers feature in combination with all of their other tools
allows you to do some pretty spectacular things. There are several
navigation features that I personally appreciate. The mouse wheel
has multiple functions on a zoomed image. Forward and backward rotation of the mouse wheel will move the image up and
down, or if the control key is pressed, it will move left or right. If
the Alt key is depressed, rotation will zoom you in and out on the
image. If the Shift key is depressed, mouse motion is restricted to
a straight line X or Y direction. Very few people are likely to need
to manipulate a photo in ways that this program cannot accomplish.
Adobe Premiere Elements 8, the second program in the box, is
the video editing/movie-making half of this combo pair. It is a
much larger install than the other half. Not only is it fairly large
unto itself, but in order to run right, it needs the content DVD
installed as well and that’s another couple of gigabytes. And, at
some point, a window popped up and informed me that in order
for this to run properly I needed to download and install Apple
QuickTime as well. PRE8 also makes use of the organizer. It allows you to import video from multiple sources, both external to
the computer and from within the hard disk. Once you have one
or more clips in the organizer window you can drag them to the
timeline/sceneline and they will be displayed in the preview window. Once you have the clips that you want to work with in the
timeline, you can click on the edit button to switch to that mode.
Once you are in that mode there are a large number of the tools
that you can make use of in different categories. Effects, transitions, titles, themes, and clip art are the major headings and there
are multiple subheadings. The program assists you in burning
your creations on CD or DVD, and the Disc Menus button opens
up a number of formatting options for creating that kind of media. The last button is Share where you actually can burn a DVD,
upload to a video site, save the creation to a hard disk file, export
to a mobile phone and other devices of that nature and an option
to record to DV or HDV tape. Bear in mind that processing video
on a computer consumes great gobs of horsepower. If you don’t
have a relatively fast computer I hope you have a whole lot of patience. If you do have a relatively fast computer, I hope you have
a lot of patience. If you have a blazingly fast computer, video
editing can make it seem slow.
(continued on Page 15)
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Photoshop Elements 8 and
Adobe Premiere Elements 8 Review
(continued from Page 14)
Amazon.com it is still selling this version for $90 and the newer
version 9 for $115 (http://www.amazon.com/Adobe-PhotoshopPremiere-Elements-VERSION/dp/B002IJA1DC). Version 9
does have some new bells and whistles and is probably worth
the difference in cost. Either version probably does more than
what most people want or need to do most of the time. But if you
want to get fancy, and create a video that you are sure will garner
oooohs and aaaahs from the audience, this program will help you
spend hours and hours and hours, if not days and weeks, accomplishing the goal. Arguably, that’s pretty cheap entertainment for
the price.

Traveling Nightmare – Almost
By Steven M. Breitbart, NOCCC

Over the last holiday, I went travelling. Specifically, I went back
to New York City to visit family and on June 6th, I was returning
home to Southern California with a stop in Chicago. My checkbook, my digital camera, my PDA and my iPod Touch were all in
my carry on bag. The flight was full and it was difficult to find
space in one of the overhead bins, but I eventually found some
space a few rows forward of my own.
When I looked for my carry-on bag during the flight, I couldn’t
find it. Someone had moved it into an overhead bin marked “No
Stowage.” I hadn’t looked in that bin because I knew I didn’t put
my bag into that bin.
It is doubtful that the bag was stolen; it’s hard to get away, but
stranger things have happened.
If my bag had been stolen, all my data in my address books
would have been compromised. My Palm PDA has a memory
card but I’ve only been able to use it to store documents, not
contacts. It synchronizes with Outlook on my desktop PC very
well. Similarly, my iPod Touch gets contact information from
Outlook. I don’t think I’ve got any credit card numbers stored on
these gadgets, but who knows?
If my digital camera had been stolen, I would have lost the camera and some not-too-important photographs.

IMPLEMENTING CIFS
The Common Internet File System
Reviewed by Anson Chapman, NOCCC (aec@cclist.com)

CIFS is a protocol (actually more then onesee below) probably the most important
in Microsoft Windows networks and is as
important as TCP/IP as all communications
between Windows machines can flow over
it. It provides file and print services and is
a carrier for RPC (Remote Procedure Call)
and NT Domain services.
Author Christopher Hertal was one of the
developers of the Samba Project and is an
Open Source evangelist that implemented
CIFS on Linux. As such he had to reverse engineer a good deal of
the protocol (and document it), thus becoming very knowledgeable. This book is a distillation of that knowledge in a form that
will help anyone who needs to understand this important protocol.
So what precisely is CIFS? Basically it is a network filesystem
plus a set of auxiliary services supported by a large group of underlying protocols. Collectively, these are called CIFS. It allows
the user to share directories, files, printers and many other things
across the networks. It was an outgrowth of the old SMB (Server
Message Block) and was submitted to (and adapted by) the IETF
(Internet Engineering Task Force).
The book covers specific details such as Domains, Sessions,
Protocol Negotiation and other difficult-to-get technical details
making it extremely valuable to anyone administrating, designing, developing and/or debugging Window’s networks.
Here you will get precise information on the Service Message
Block (SMB), NetBIOS over TCP/IP (NBT), browser services
and authentication. It provides detailed views of the protocol as
well as code samples, packet traces and source code as well as
some obscure documentation. It is well written if a bit iconoclastic such as having a section on how to brew a good cup of
tea (Appendix A) as well as chapters titled called “A Beautiful
Day in the Network Neighborhood” (Chapter 19) and “Meet the
Neighbors” (Chapter 20). The book also includes the official
SNIA (Storage Networking Industry Association) Revision 1.0 of
the CIFS Technical Reference.
This is essentially a very technical document on the CIFS filesystem, its design, development, and implementation. Using this
book alone should allow anyone to readily understand and come
to grips with this standard of the Internet.
http://www.pearsonhighered.com/educator/product/Implementing-CIFS-The-Common-Internet-File-System/9780130471161.
page
Msrp=$45. amazon.com = $28; 672 pp; published 2003.

In the very near future, I will be investigating ways to password
protect and/or encrypt these data. In the interim, I’m going to
keep things in a separate bag under my seat.
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Club Business
Board Meeting Minutes
June 6, 2011
The new NOCCC Board held its first meeting at President
Jim Sanders’ residence on Monday, June 6, 2011.

Public Relations: given by Mary Cornett. Mary did not
have anything to report.

All Board members attended except Dr. Patricia Adelekan
and Steven Breitbart. The Vice President’s position is
open.

Publications & Reviews: given by Ted Littman. Two
books were taken for review at the meeting on Sunday.
Two reviews are still outstanding. Tony Loechner has volunteered to help produce the newsletter. He has considerable Desktop Publishing expertise.

Secretary’s Report: given by Ted Littman. The Board
Meeting Minutes of the May 2 Board Meeting as prepared
by Steven Breitbart and published in the June 2011 Bytes
was motioned for approval, seconded, and approved by all
in attendance.
Treasurer’s Report: given by John Heenan. Net income
for coffee, cookies, and donuts was $15.72. The Raffle
earned a record $120; cost of the prizes was not reported.
Consignment took in $3. Two club t-shirts were sold at a
loss of $4; 28 are remaining. The average cost of producing and delivering the Orange Bytes for the past ten months
ending in May was $1.36 per copy.
Memberships: As of May 30. Regular (1-yr.) = 157, Regular (3-yr.) = 12, Family = 7, College Student = 1, Newsletter = 12; Total of 189 Members, which is a decrease of 3
from the previous month. In April, there were 14 member
renewals. The Board accepted the Treasurer’s report.
Opening & Closing: Richard Miller made the coffee and
Bob Love bought the donuts and cookies. There were no
significant problems.
Main Meeting: The presentation by Gene Barlow on two
Acronis products was attended by 41 people. It ran over
an hour and there were many questions. Before the wellreceived talk, Jim Sanders called for elections. No members
present volunteered to serve. The slate as shown on page 4
was elected. The VP position remains unfilled.
Programs: The next Main Meeting is Sunday, July 10th,
followed by the BOD meeting on Monday, July 11th at the
President’s residence. We do not have a firm commitment
for a speaker next month. Jim will explore several possibilities. Ted suggested that the computer companies be
contacted to see if “canned” presentations were available in
lieu of live speakers.
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Membership: given by Ben Lochtenbergh. Ben discussed
setting up NOCCC accounts on Facebook and other social
networking sites as well as a Google email account.
Raffles: given by Gerry Resch. Ticket sales were good and
a number of high-value prizes were raffled off. Jim will
procure items for the July raffles.
SIGs: given by Dallas Hazelton. Attendance at the SIG
meeting varied widely from one at the Beginners PC Q&A
to 28 at the Advanced PC Q&A. The Microsoft Office SIG
was not held in the absence of the SIG leader. The Digital
Photography SIGs had 6-8 attendanees.
Old Business: None
New Business:
Jim discussed the elections, the need for a Vice President,
and the poor response by members to serve. Ted noted
that the decline in membership was becoming a problem
since our postal bulk-mailing rate requires a minimum of
200 newsletter copies and membership is now down to
187. There is a real issue of the club folding in the near
future due to lack of help from the members.
Jim received the meeting dates from Chapman U. for the
next 11 months. Chapman values the annual use of their facilities by NOCCC at about $11,000. We are allowed their
use at no charge!
Omni Technics offered to provide 1 or 2 computers for
NOCCC to donate to a local school.
The meeting was adjourned at 9:30 PM.

Orange Bytes

June 5, 2011
Main Meeting Report
By Steven Breitbart, NOCC; Photos by John Krill, NOCCC

Club Business
NOCCC President Jim Sanders opened
the meeting and conducted the elections. (See President’s Message for
comments.)
Main Meeting Topic
Speaker Gene Barlow has visited
NOCCC many times. Gene and his
wife Linda own User Group Relations (www.ugr.com), a consulting firm
that specializes in representing computer software companies to
the user group community. They typically demonstrate Acronis
True Image Home 2011 and Acronis Disk Director 11 Home.
These products and Gene’s procedures are used for partitioning
hard disks and backing them up.
Gene initially described the hard disk on his laptop computer,
which was divided into at least 3 partitions. The C: drive was
for the operating system and software. Two other partitions were
designated for data and digital photographs. He mentioned that
he does compress the backups of his data but not of the backup of
the photographs since the photographs are already in a compressed format.

Managing Partitions
Several years ago Gene spoke
to us about Partition Magic
made by Powerquest to easily
partition the hard disk. Powerquest was sold to Symantec
about eight years ago, but
Symantec did not update Partition Magic to accommodate
Windows Vista, Windows 7 or
large hard disks, so it became
obsolete and was discontinued soon afterward. According to Gene, the best software now
available for setting up and maintaining partitions on the hard
disk is Acronis Disk Director, currently in version 11, which was
released last summer.
Acronis Disk Director 11, shows a text list and graphical diagram
of the hard disks in the system. Again, using Gene’s laptop as
an example, Hard disk #1 was about 250 GB and had 5 partitions. Hard disk #2, used just for backups, was an external drive
connected via USB, and had one primary partition. Symbols for
each hard disk is shown, each partition in the hard disk is shown
by a separate box. A colored bar over the box indicates what type
of partition it is; primary (green bar) or logical (tan bar). The
dark part of the bars indicate how full the partition is.
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According to Gene, the tutorial he wrote has a thorough explanation of the difference between primary and logical partitions. The
tutorial comes with the Acronis software he sells. A simplified
explanation is that the master boot record has only four slots to
point to partitions; you can have four primary partitions, each
with a different Operating System, and no logical partitions. A
primary partition can be made bootable by installing an Operating System into it. In order to expand the capabilities of the computer, one primary partition was changed to an extended partition
and the logical partitions are created within it. There is no limit
on how many logical partitions can be created.
There was a hidden partition on Gene’s laptop called “System
Drv” with no drive letter. It is used for extensions to Windows 7,
and was put there by the hard disk manufacturer. Another hidden
partition for system recovery was also present. While not listed
by the software, it was assigned drive letter Q.
Gene demonstrated using Acronis Disk Director 11 to add a
partition. First, he resized one of the other partitions, to make it
smaller by approximately 80 GB. Then he created a new partition in the 80 GB of empty space. NTFS format was selected,
but other formats are available. The new partition was labeled
“My Stuff” and assigned drive letter S. However, up to this point
no changes had been made to the hard disk. The changes are not
made until you click on the commit button. You can defragment
the partition before resizing it, but it is not required. Gene said it
may save you a few minutes in the creating of the new partition.
New features for version 11 are support for newer operating systems, such as Windows Vista and Windows 7 as well as dynamic
disk support, which include things such as RAID disks and other
disks typically used by businesses.

Hard Disk Backup and Restore
The #1 thing you can do to protect a
hard disk is to back it up. But what
method is best? Backing up to DVDs,
another hard drive or to the Internet?
According to Gene, backing up to an
external hard drive is best. You can
store an image of your computer, the
operating system, the software and the
data, which can be used to rebuild your
system after a hard disk crash. At present, online backup services such as Carbonite and Acronis (they
have online backup as well), only back up your data. Gene heard
of one customer who needed three days to back up all of their
data the first time.
Gene recommends that the external hard disk be designated only
for backups. The external hard disk can be same size as the main
hard disk; compression of the backups allows you to store several
backups on the external drive.
Continued on Page 18
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Continued from Page 17

Backup software should be partition based, not file
based. Again, file based methods, now considered
obsolete do not back up the operating system or software. Using file based backup methods, after a crash,
assuming you get a new hard disk physically installed,
you still need to format the drive, install and update
Windows, install and update your software, update
your settings, then restore your data files, which can
take days. Using partition based software, you can
restore to a new, empty hard disk. There is no need to
format or install the operating system.
Acronis True Image 2011 can do full, incremental,
or differential backups. An incremental backup just
captures the changes since the previous backup, and
needs to be stored on the same drive as the original,
full backup. Gene recommended a full backup every
month plus an incremental backup each week. Later
he recommended backing up data every day. Each
partition on the primary drive is backed up to a separate
folder on the external hard disk.
After a primary hard disk crash, you install a brand new
hard disk and boot up from the bootable restore CD
that Acronis True Image 2011 tells you to create when
you first install the software. Normally, you start the
restore from the last incremental backup, but it is not
required; you can start the restore from an earlier set if,
for example, you think a virus got into the last backup
or if the incremental backup was corrupted.
Gene cautioned on creating too many incremental
backups. If an incremental backup gets corrupted, all
data stored after that is useless. He recommended a
full backup after every 5 to 7 incremental backups.
The new version of Acronis True Image, 2011, has a
custom setting which will let you set this up automatically. For example, every 6th backup can be set to be a
full backup. Acronis True Image 2011 also has a new
easier interface and more automation capabilities. Both
Acronis True Image 2011 and 2010 will work with
Windows 7.
Gene told us about a free program available from Acronis called Acronis Drive Monitor. This checks your
hard disk from time to time and notifies you if it thinks
the hard disk is about to fail. He assured us that this is
not spyware, and doesn’t communicate with Acronis.
Gene had copies of Acronis Disk Director 11 and Acronis True Image 2011 for sale at the meeting. Normally,
Acronis sells them for $50 each for a downloadable
copy or $63 each if you want the CD. At the meeting,
they were on sale for only $25 each!
Another interesting meeting! See you next month.

18

June 5, 2011 Raffle Winners
Photos by John Krill, NOCCC

Frank Emanuel
Netbook

Don Blake
NOCCC T-Shirt

Ed Koran
2 CD-R Boxes

Gordon Strickland
Flashlight

Tony Loechner
1 TB Hard Drive

Don Armstrong
T-shirt

Mary Cornett
John Krill
Don Armstrong
Logitech
Keyboard
AcronisTrue Image
Router Security Book

Barth Bybee
Ball

Don Armstrong
Webcam

Your photo could be here - but only if
you buy a raffle ticket.
$1 per ticket or 6 tickets for $5!
Remember, parking permits are good
for 2 free tickets!
Orange Bytes

SIG Meeting Reports
Beginner’s Digital Photography
By John Krill, SIG Leader
At Sunday’s meeting, I discussed two
software utilities that may help you keep
your photos up to date and a handy web
site that allows you to send very large files
to anyone. Lastly, we went over Photoshop
Elements Organizer. We have spent a lot
of time with Picasa but very little with the
Photoshop Elements native image organizer.
SyncToy 2.1 is a free application that synchronizes files and folders between locations. Typical
uses include sharing files, such as photos, with
other computers and creating backup copies of
files and folders. You can download the utility from here: http://www.microsoft.com/downloads/en/details.
aspx?FamilyID=c26efa36-98e0-4ee9-a7c5-98d0592d8c52

I’ve been lax in posting to the blog. I hope to correct this. Because our meetings are once a month and last for only one and a
half hours there is much more I can cover with the blog.
Hopefully!
If you have a special request for information regarding digital
photography let me know. E-mail me using the address listed
below.
Check out the SIG Blog for other information and maybe info on
what we will discuss at the next meeting.
See you at the next meeting.
Email: noccc.bgphotosig@gmail.com
SIG Blog: http://nocccbgphotosig.wordpress.com/
Picasa Photos: http://picasaweb.google.com/noccc.bgphotosig

This SIG meets in Science 127 at 9:00 a.m.

The second utility is a free web tool called You Send It. The web
site is www.yousendit.com.. Because most, if not all, e-mail
services put a limit on the size of files you can send you need
another option for sending large files. If you send photos to
friends and family you may have already encountered the size
restrictions at your e-mail service. You Send It lets you send very
large files. If you are sending more than one file you only need to
ZIP your files and then upload it to You Send It.. All they require
is the e-mail address of the recipient. They will notify them when
the file is ready to be downloaded.
Photoshop Elements Organizer is Elements native tool for keeping track of all your photos. We will go over Importing your
pictures, Adding Keyword Tags, and using Albums for collecting
photos from multiple locations with a common theme.
As always, we answered any and all questions.
July 2011: I plan on continuing our discussion of Photoshop Elements. If anyone has a question for me let me know and I will try
to answer it at the next meeting.
Know of any good Photo editing books? I’m trying to figure out
what is good. It isn’t easy unless you have the book in hand and
use it over and over to answer questions. So if you have used
such a photo editing book, please let me know.
Standard Stuff That Is Always In This Report
This report should be up on the SIG’s blog. I may go into greater
detail and I will include screen shots as well.
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Microsoft Office
Tia Christian, SIG Leader

These sessions are an open forum for
problems incurred using Microsoft Word,
Excel, and Outlook and their resolutions.
During these SIG sessions, topics have
been discussed on creating Labels in Word
and exporting to Excel and printing them.
Primary session topics have included the upgrade from Microsoft Office 2003 to Office
2007; using Add–In; e-mail compatibility
issues from Office 2003 to Office 2007; installation requirements
for installing Office 2007 on a PC using Windows XP as well as
one using Vista 2007; PowerPoint 2003 compatibility issues with
a slide presentation consisting of an AVI and file viewing. Future
meetings may include discussions of OpenOffice.org, a free office suite.

This SIG meets in Science 109 at 9:00 a.m.
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Advanced Digital Photography
By Larry Klees, SIG Leader
Last Month
The June meeting was about focus stacking. In
a typical photograph the depth of field (DOF)
equals approximately half the width of your
subject. With telephoto shots and especially
with macro shots, the DOF can be considerably
less. If conditions permit, you can use a smaller
aperture to increase the DOF, but not always as much as you
would like. Furthermore, when the aperture gets too small, your
image will loose some of its sharpness. Other times you don’t
even have the option of using a smaller aperture.
It is possible to take two shots of the same image with one
focused on the foreground and one focused on the background
and merge them together so that in the final image both the
foreground and the background are in focus. This is called focus
stacking.
In reality, several images must usually be combined to get the
desired results (for some macro shots, more than twenty images
may be stacked). Doing this manually varies between difficult to
nearly impossible. However, there are numerous programs that
can do the job for you and they are very easy to operate.
Zerene Stacker was the program demonstrated at the meeting,
but there are many choices available on the Internet. (Some
are free.) A screen capture of Zerene Stacker is shown below. I
simply dragged eight images into the upper left box, clicked on
“stack all” and watched as the program took about one minute to
combine the eight shallow DOF images into a single sharp image
with a DOF that is deeper than the image is wide.
The large image in the center box is one of the eight shallow
DOF images while the image in the right box is the finished
product. If you count the squares on the chess board you can see

the image is about six squares wide and seven squares deep. Note
that it is in perfect focus from front to back.
The eight shots in this image were taken with a point and shoot
camera in the automatic program mode using auto focus. (While
manual focus is the preferred method there are some simple tricks
you can use to make autofocus work.) Below are two setup shots
to show how this was done.
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The left image shows a simple tabletop with a chessboard, a lamp
and a point-and-shoot camera on a small tripod. It is possible to
hand hold the camera, but unless you’re a masochist, use a tripod
or a box, etc. to hold the camera steady. (You will see why later
in this report.)
For focus stacking to work, it is crucial for you, the photographer,
to precisely control focus of each of the individual shots; preferably without moving the camera from side to side. If your camera
only allows auto focus, you must trick it into focusing where you
want. The right hand setup shot above shows a rectangular zone
where the camera will focus when you press the shutter button
half way. With my left hand, I placed a small white card with text
into this zone at the distance where I wanted the camera to focus.
I used my right hand to press the shutter half way; when the camera focused, my left hand pulled the focus target from the picture,
and my right hand pressed the shutter button the rest of the way. I
did this eight times with the target at the proper distance for each
of the eight chess pieces. The eight JPGs were then dragged into
the upper left box of the Zerene program.
Also note the +1 in the bottom center of the camera’s display.
That’s because I set the camera to over expose by one f-stop
so that when the white target was removed I would get a good
exposure. (Also by the time I took the setup shot, the battery was
getting low, which has nothing to do with the focus stacking.)
If your subject matter makes it inconvenient to place the focus target in the image, try placing a ruler (holding the target)
horizontally just below and in front of the camera’s lens. You
can then temporarily place a mirror at a 45º angle in front of the
lens to focus on the target, and then remove the mirror to take the
picture. Then move the target to a new spot along the ruler for the
next shot.
The above method is the least expensive way to do focus stacking. For a little more money; the image below was created with
a manual
focus DSLR
mounted on
a focusing
rail. (With a
focus rail the
entire camera is moved
to focus the
image.)
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Twenty eight images were stacked to get a DOF more than twice
deep as the image is wide. Unfortunately there was a slight
breeze. Remember I said hold the camera steady. (You will see
why later in this report)? This is why. With many stacking programs, anything that moves between one shot and the next will
blur or look like a multiple exposure. Note how the leaf near the
upper left hand corner looks like a multiple exposure and below that there are
a couple of blurry green blobs. These
are because of the breeze.

At the July meeting
Perhaps you are having troubles
blending parts of a panorama
because the colors don’t quite
match.

The setup for the above shot is shown
on the right. The camera is mounted
on the focusing rail which is in turn
mounted on a tripod. One of two off
camera strobes is mounted on a second
tripod. The other off camera strobe was
hand held. The black umbrella was
only partially successful at blocking the
breeze.

Perhaps you want to remove all
the people and other cars from
your Batmobile shot taken on a
Saturday. So you go back to the
same place on Monday and take
another shot with no people or
cars. Problem is Saturday was
100% overcast and Monday was
sunny so the colors don’t match.

You can get more information about Zerene Stacker here:
http://www.zerenesystems.com/

Precision color matching comes
to the rescue.

If you really want to spend a lot of money, you can buy a focusing rail with a built-in stepper motor and a custom computer to do
the focusing and trigger the shutter. Try this site.
http://www.cognisys-inc.com/home_cogn.php

Come to the meeting and learn how it is done.

Visual Programming

Anson Chapman, SIG Leader

This SIG is lead by Anson Chapman and is a continuing discussion group about computer programming using Visual
Basic, Visual Basic Script, Visual
C, Visual C++ and Visual J++ for
Beginners.
This SIG meets in Science 111
at 9:00 a.m.

Understanding Operating Systems
Charlie Moore, SIG Leader

This SIG is lead by Charlie Moore
and is a continuing discussion
group about Operating Systems for
computers.
This SIG meets in Science 111 at
10:30 a.m.
July 2011

Perhaps you want to place two
portraits side by side in frames
or in an album but the colors
don’t match.

This SIG meets in Science 127 at 10:30 a.m

Microsoft Access
By Bob Dickson, SIG Leader

The SIG session was not really held
in June. Helen’s husband died and
she had many issues to deal with that
were more important than her “Dolls
Project.” God bless her. She let me
know she’ll be ready to resume her
project development in July. I was in
the room and ready to do any work in
Access that was requested but there
wasn’t any requirements. While waiting, I continued working on my Excel VBA project (see other
article). After about 30 minutes I packed up and went to the main
meeting. If anyone has some interest or questions regarding Access database development, come up to Sci 306 at Noon and let’s
talk. Access databases are terrific for small business / personal
management of data. The relational database can be a real space
saver and provides many features that can save lots of time and
effort. Curious? Let’s talk. Got a great application you’d like to
boast about? Let’s see it.

This SIG meets in Science 306 at Noon.
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Visual Basic
for Applications
(Access/Excel VBA)
By Bob Dickson, SIG Leader
The June session was an exercise in pulling
one’s hair and digging into the dark corners
of Excel VBA Help looking for a method
to orient the User form into Landscape
mode. Grrrrr! It’s e-a-s-y to do in Access
but in Excel VBA – NO WAY! Incredible. Does Bill Gates know about this?
OK, Richard spent considerable midnight
oil (he’s a self-employed consultant so this
was no small investment of his time. I hope I don’t get a bill. He
said he ‘volunteered’ his time (I’ll spring for coffee and a donut.)
looking for a solution to my quandary. He did find a method.
Not a direct, simple method but it kinda worked. It required creating an ad-hoc worksheet and a bit-map picture of the user form.
The method had an orientation option which included landscape
mode. OK, we copied it to my PC and tried it. It worked –
kinda. That is, it did print out the user form in landscape but the
result was a poorly displayed bitmap image with jagged edges.
Better than not at all but it really doesn’t do the job. I’ve been
trying to connect with someone in a user group in the MS help
groups to see if someone, anyone has come up with a method
to direct the printer to switch to landscape mode under program
control. I should state that one can manually set the printer to
landscape mode but that isn’t automatic nor under program control so I’m going to keep working on this little ‘opportunity’ to
expand my (our?) knowledge regarding this issue. Stay tuned.
Otherwise, I managed to generate some neat (to me, at least)
routines to work with the user form and provide the operator
some nice features. This is my challenge to get into Excel VBA
and it’s quickly getting less difficult. A big THANKS to Richard
for investing his time and for his willingness to coach the SIG
leader. It’s getting exciting, educational, and I’m about ready to
produce a product that I can give to someone to use on a daily
basis for real work. Come on up to Sci 306 at 10:30 AM and put
in your 2-cents (about the only place these days that 2-cents has
any value). Be sure to fill your coffee cup and get a donut.

This SIG meets in Science 306 at 10:30 a.m..

PC Q&A
By Jim Sanders, SIG Leader
One of the questions this month was on the
topic of Registry repair/cleanup. In particular, the question was about a product that
is named “RegistryFirstAid” by a company
called Rose City Software. The question
was multi-part; does the program do any
good, does the program do any harm, does
it do what it claims, do I need to have done
what it claims it does, what’s with this free
scan claim and then a request for money.
The answer is rather involved and not nearly as definitive as I
would prefer. There is at least a couple dozen of this class of program being offered to the computer using public. A great many of
them are first encountered as you are out doing something on the
web and you see some sort of an ad, not infrequently a pop-up,
that’s usually in the form of a warning or a question. The kinder
question is usually of the form “Is your PC running slow?” It then
goes on to mention several things that could be slowing down
your computer, offers itself as a cure for the problem, and says
all you have to do is download the program for a free scan. The
other common approach is the scare tactic. A “corrupt” Registry
can cause you all kinds of problems. Download our program for
a free scan and fix the Registry problems before they cause your
computer to crash. In most cases, if you download the program
and run it, it will find several hundred “problems.” Some will
offer to fix a limited number of those problems. In the case of
RegistryFirstAid, I believe the number is 100, but then to fix the
rest of the problems that it “found” it tells you that you will have
to spend money. Frequently the cost seems to be about $29.95.
While it is true that a sufficiently corrupted Registry can cause
your computer to crash, that doesn’t happen very often. What is
true is that frequent installing and uninstalling of software packages can leave orphaned bits of stuff on your system and in the
Registry. Seldom does an uninstall actually remove everything
that was installed by a program. A lot of the detritus takes up
space on your hard disk and/or in the Registry but causes no real
harm, nor slows down your computer to a significant degree.
Would your computer be better off if the program actually did
all the wonderful things that it claims to do? Probably. Is there a
risk that the program will do something that actually causes you
harm? Regretfully the answer is yes. In particular, there are far
too many examples of this type of program actually being malware. So before you download any of these programs, I strongly
recommend that you do your due diligence. In particular, Google
the program name and include the keywords virus, Trojan, phishing, malware, and tracking. Once you are fairly sure that the
program is not one of the undesirables, then you should check for
reviews and that gets a little tricky. Most of us have heard some
variation of, “Believe nothing of what you read or hear and only
half of what you see.” With the advent of the web, that pessimistic and cynical phrase has actually become more relevant. Since
continued on Page 23
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PC Q&A

continued

continued from Page 22

it costs next to nothing to provide all kinds of text for you to read
on the Internet, and ditto for audio to hear, coupled with little or
no recourse against those who lie.
The other phrase “trust but verify” should be thrown away. In its
place I would suggest substituting “distrust and verify in multiple
ways.” And considering the multiple ways in which computer
technology allows what we see to be modified, maybe we should
drop down to only 10% of what we see.
If you Google this: rose city software registry first aid ……….
and look closely at the first four entries you will find that they
are all rosecitysoftware.com links. A similar situation will probably be found with most of the other software offerings in this
category, and for that matter, most any other category. Then there
are the “independent” review sites that sing the praise of a given
product and in too many cases if you were able to trace the ownership of that website, you are likely to find that it is owned by
the company whose product is being praised.
The irony of this report of course is that in large part it is based
upon what I have read on the Internet. Still, I fancy that I am
better than a lot at reading between the lines and separating the
wheat from the chafe. Most all of the URLs that you go to that
sing the praises of any one particular product are full of praises
and great claims that sound very believable. From my point
of view, a real problem is that I have yet to see one that offers
verifiable proof that they do what they claim. If you go to this
URL, http://answers.microsoft.com/en-us/windows/forum/windows_vista-performance/are-registry-cleaners-useful-or-are-theythat-bad/12808dab-946c-4eb6-816b-aea5b3e7e16c?page=1, you
will get a good example of the controversy that exists about the
subject. It and several others that I looked at seem to agree that a
number of programs fix some of the simpler problems that aren’t
really much of a problem to begin with. But some of the more
ambitious programs that attempt to fix some of the more severe
problems can actually do more harm than good if the person using the program isn’t knowledgeable enough to review those fixes
before authorizing them. In addition, they were not smart enough
to do an image backup in case it happened to make their computer unbootable. One piece of advice crops up in several places.
The same piece of advice that Nick Anis gave when he did his
presentation at the club a few months back and listed the utilities
that he likes. That was to use CCleaner to tune up your PC. A free
program that you can download.

Jim’s two SIGs meet in the Irvine Hall at 10:30 a.m. and
12:30 p.m., respectively. The first is the Beginner’s PC Q
& A and the second is for everything and everyone else.

Linux Desktop & Administrator
By Bob Ray, SIG Leader
In our last meeting, we reviewed a number of GNU/Linux Distributions. Included but not limited to: Fedora 15, Debian y6.0,
Ubuntu 10.10, and Ubuntu
11.4. The reviewing of the
Ubuntus was in part a comparison of one to the other.
We booted Debian 6.0---the
current and latest version
from an attached stand-alone
SATA hard drive using a USB
conversion facility. We were
unable to utilize much of this Distro because we were unable to
connect to the Internet and thus limited to using basically a “frozen” desktop. This problem will be further researched to enable
full usage of the Internet and browser applications. When this
problem is resolved, we will be able to continue experimenting
and using this Distro in upcoming Linux SIG meetings.
We booted a fully-loaded and fully-installed Fedora 15 from a
stand-alone SATA hard drive on a USB conversion cable. We
were then able--as a group--with a fully functional Internet connection to experiment and “click around” on the newest release
of the GNOME 3.0 desktop. GNOME 3.0 is a completely new
concept in the Linux desktop world. My understanding is that
the developers worked on this new GUI desktop for over five
years before its release The changes are so significant and so numerous it would be a major work to describe these new features
in this writing. One problem that occurred as we started with
Fedora 15 was that we had difficulty in getting the dual display
to work on the Laptop and with the screen projector. This was
eventually resolved by using the display screen configuration
GUI system application and clicking on a “little” box titled
“Mirror Image.” This action then caused both displays to work
perfectly. Note that this problem is handled automatically in using the Ubuntu Distros.
Lastly, listed here---but not lastly in our meeting, we looked
at, compared, and reviewed the Ubuntu 11.4 release which is
the newest and latest Distro code named and known as Natty
Narwhal to the older Ubuntu 10.10 release known as Maverick
Meerkat. Ubuntu 10.10 uses the GNOME 2.x desktop as the
default standard where as the newest 11.4 uses a new and
completely different desktop GUI called “Unity” which is absolutely nothing like the older GNOME 2.x. The difference between these two is currently almost beyond description---at least
by me. How about Life-on-Earth as you know it as compared to
Life-on-Mars as you Don’t know it. Among many of
the big problems here, was and is, that many of the applicacontinued on Page 24
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Linux Desktop & Administrator continued
continued from Page 23

tions available on the older Ubuntu 10.10 are not present and/
or are just not available on the newer 11.4. These applications,
which consist of many of our groups favorites, are gone and/
or do not work on the newer Natty Narwhal under the Unity
desktop GUI and are also not available for Download. Much of
the current Internet talk traffic regarding this new approach by
the Ubuntu developers that they had a good thing going progressively straight forward, but they have “possibly” made the wrong
move..as in a left-hand turn on the road to “Nowhere Land?” The
future will soon tell.
Our future meetings will continue with exploring many of these
new GNU/Linux Distros and experimenting further with these
new GUI desktops.
These SIGs meet in Science 131 at 9:00 a.m .and 10:30 a.m.

Mobile Computing
By Ben

Lochtenbergh, SIG Leader

This SIG
The June meeting was well attended including some new faces, and
some regulars were out of town.
The format of this meeting was
more laissez-faire, no preplanned
ten demos since there are many
more possible. I let it be guided
by the spur of the moment. I have
a list of possible demos to draw
from, and demonstrate whatever
seems appropriate. Spontaneity
is often a good thing. The Power
Point Presentations are helpful, but
I’m uncertain if these are worth
publishing on the Internet, ten year
old technology is used that will be
obsolete soon.

but really nice when you get used to it. I don’t look for the
power-on button; I just feel it. Anyway, after someone turns it on
it shows 9 dots, in a 3 by 3 configuration. Sliding a finger connecting the dots correctly opens the tablet device (Xoom). This
is easier than typing a password, which of course still remains an
option, but I’m unlikely to go back to that. This is one advantage
of a touch screen! I demonstrated the changing of my passslide-code. This involved getting into the Settings (system app)
where Android devices are configured. I think it is very logical
to do, and think it was perceived that way. One more security
item is that my telephone number displays on screen, so if after
the Xoom is turned on, and someone just found it, and wants
to return it, he can call. I have the same security on my Droid 2
smartphone device (do you?).
Google Translate
One of the attendees, Dennis Martin, during the meeting asked
about a Translate App. I responded that there was such an App,
but that I hadn’t downloaded it. Well, the next day I checked, and
found the Google Translate App, a free five star, 5-to-10 million
downloads worldwide, and created by Google, Inc. I installed it,
played with it, and was amazed again! It translates back-and-forth
between 50 languages in text. But also allows voice input and
voice output in a number of languages, including some I know.
This worked surprisingly accurate I can’t wait to demonstrate it
in the next meeting.
Android Magazine on Newsstand
Also, I found (a first of its type) an Android magazine (watch out
Apple), I couldn’t resist buying it. The guy at checkout comment
he had a Xoom, and doesn’t need to buy magazines. The magazine has over 170 pages of tutorials & features, its title: Android
Tips, Tricks & Apps, and is published by Imagine Publishing Ltd.
Website: www.imagine-publishing.co.uk. There is no mention
of any tablet like the Xoom, but it is packed with good Android
phone stuff, presented the old fashion paper magazine way. Richard Miller showed us the same magazine NOCCC Sunday!

HDTV
Again, Kaz Adachi brought his flat panel TV, to display the
Xoom screen. This is the best way, to date, to show what’s going
on in the demonstration.
A touch of Security
Demonstrated was how I secure my Xoom with a sort-of-password, in case I lose the device, and falls in the hands of someone
else. One thing, after they locate the power-on button, which is in
an unusual place, on the back side corner, which is strange at first,
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Richard pointing to his DROID 2 resting on his laptop PC.

This SIG meets in Science 109 at 10:30 am
Orange Bytes

From the Desk of the
Membership Chairman
By Ben Lochtenbergh, bal@msn.com

Parking Two Bucks
I made a two-and-a-half minute movie of myself buying an
underground parking ticket. I’ve been using a credit card the last
couple of months, ever since I lost two quarters in the machine.
The ‘movie star,’ who was scheduled to perform for this, was on
his way back from New York, so couldn’t perform. I still wanted
to post it on YouTube, but my wife advised against it, after she
saw the movie. It’s very amateurish (my characterization), with
shaking one-handed camera work, and examples of overcoming
mishaps (which I thought useful), but she thought is not a good
use of anybody’s time.
The points however are: 1) use the garage worth two dollars, 2)
use YouTube if you haven’t already, 3) and NOCCC will have a
presence on YouTube.

There are other fundamental ideas that need to be changed.
I’ve experienced FB for some time, and feel something like a
strong wind, pulling me into a certain direction “Social Networking” I could call it compelling. Younger people seem to have less
of a problem with the FB paradigm, while people around my age
tend to see many hurdles, and I see myself in the middle of trying
to overcome these problems.
I have established Email, Facebook, and YouTube accounts for
use by NOCCC. I have a problem with having the whole world as
a ‘friend’ of NOCCC. I’d like to see a few NOCCC members be
a friend of NOCCC (and exclude everyone else). I like someone,
like myself, to control who is a ‘friend-member.’ I visualize 200
NOCCC members, of which only 20 are NOCCC FacebookMember-Friends. We’ll use it only for computer & club interests!
I don’t know how to do that, thus no FB recommendation from
me yet.
The status of this project: Don’t know enough to ask the right
questions, don’t know who to ask in the club, thus must: learn
how, give up, or change ‘feelings’ about this social networking
phenomenon.

The Facebook Project
Yours truly has spent considerable time investigating what this
social media can do for your club. I found it extremely difficult to
make FB fit, into what I think would be useful to our club members. I tried a number of ways, with far-from-desirable results.
You may ask: “Who are you, making Facebook do what YOU
want it to do?” “Don’t you want to follow the FB rules?” Well,
I’ve been in computing a long time. I’ve earned my money working with computers. I’ve lived on this planet seven decades, I call
only a few people my friend, and I like it that way. Facebook calls
everybody my friend! It wants me to connect with all my contacts
‘as friends’ from all sources, and then, based on those sources,
wants me to invite many more to be my friend. The list seems
endless (I stopped after looking at about 1000 possible friends).
Only one benefit here: I saw the sister of a ‘real friend’ whom I
want to connect to electronically; I’ll do that later. Of course it is
very nice if all people are friendly towards me (and to everybody
else), and if there are no unfriendly people in the world. It’s headstrong to argue against that notion, but calling everybody a friend
diminishes the meaning of being a friend. I can’t maintain proper
attention with that many so-called-friends, without shortchanging
my real friends. Perhaps I’m old fashion. I’ve experienced people
in foreign countries where they barely speak English, address me
routinely with the title ‘Friend.’ Are they casual contacts simply
expressing they are not hostile? It seems to me that I (we) must
change the meaning of that word (in our minds) to get along with
Facebook. I can change, but that would only be the tip of the
iceberg named Facebook (Zuckerberg).

July 2011

A typical gathering of club members on an NOCCC SUNDAY
MORNING, enjoying coffee, donuts, and the offerings on the
Product Review and Consignment tables
I take my children everywhere, but they always
find their way back home.
Illegal aliens have always been a problem in the
United States. Ask any Indian.
Most people would like to be delivered from
temptation, but would like it to keep in touch.
Robert Orben
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Thanks to Our Members Who
Renewed in May 2011
Anson Chapman
Darlene Dean
Thomas Fitzsimmons (Family)
Frederic Fuller
Brenda Gonzalez
Carl Grinstead
Phillip Hahn
George Haldane
T.C. Harrison, Jr.
Richard Kingsland
Vince Lazore
Dale Myhra (Family)
Eric Saca
William Thomas
Henry Trinh
Rene Zufferey

NOCCC Fee Schedule
The fee schedule has been set up to increase club membership,
attract people with an interest in computing, and attract local
computer-related businesses to place ads in the Orange Bytes with
or without becoming NOCCC members. We are also offering
members the opportunity to help our club financially by making donations that should be income-tax deductible since we are
chartered as a non-profit 501(c)(3) organization. Donors will be
acknowledged in the Orange Bytes and the Membership level
will be shown on the Member’s Badge. Your regular dues is tax
deductible!

Pig SIG Open to All
Meet us outside Irvine Hall from about noon to 12:30
p.m. There are several benches where NOCCC
people gather, eat and chat. Just
look for the member badges,
grab a chair and join in! This
is an informal group; so many
different subjects are discussed.
It’s a great opportunity to mix,
mingle, and network!

Free coffee & tea at the July meeting!
Donuts $1/Each & Cookies $.25/Each
No Freebies!
Put your dollars & quarters in the
collection can.
FREE AD SPACE
If you are an NOCCC member, and have a computer-related,
non-commercial or “Talent Available” ad that you would like to
have placed in this newsletter or on the NOCCC web site, send
an e-mail with a copy of your business card or ad to the NOCCC
Editor at editor@noccc.org.

Membership Level ($)................................ 1 Year .................3 Years
Individual Member..................................... 35............................... 90
Each Additional Family Member ............... 15............................... 45
Full-Time* Enrolled College Student ........ 20
Enrolled High School Student ................... 15
*Minimum 12 Semester Hours
Business Member + Ad (Business Card) ..180
Business Member + Ad (¼ Page, ½ Page) 465 , 800
Business Member + Ad (Full Page) .......1,475
Membership Donations ($)
Contributing Member..................................75
Supporting Member ..................................100
Advocate Member .....................................250
Patron Member......................................... 500

NOCCC Bylaws

The club’s Bylaws are available at our website:
www.noccc.org/bylaws/.
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Your business card
would look good here too!!
For information about advertising in the
Orange Bytes, contact editor@noccc.
org.
Classified ads by NOCCC members cost $5
for 1-25 words and $10 for 26-50 words.
Orange Bytes

Publication Information
Orange Bytes is published monthly by:
North Orange County Computer Club
P.O. Box 3616, Orange, CA 92857

Commercial display advertisements
are welcome, contact
editor@noccc.org.

RATES

All opinions expressed herein are those of the individual
authors only and do not necessarily represent the opinions
of the NOCCC, its officers, Board of Directors, the Orange Bytes newsletter or its editors. The NOCCC does not
guarantee the accuracy or the correctness of advertising or
articles in the Orange Bytes, nor does the NOCCC intend to
endorse, rate, or otherwise officially comment on products
available. Therefore, the readers are cautioned to rely on
opinions presented exclusively at their own risk.

One Page Vertical .... 7.0” x 9.5” ....$150
Half-page Horizontal 7.0” x 5.0” .... $80
Half-page Vertical .... 3.5” x 9.5” .... $80
Quarter-page..............3.5” x 5.0” .... $45
Business Card........... 3.5” x 2.0” .... $15
Center Spread ..........14.0” x 9.5”.... $300
Deadline: Tenth of the month

Trademarks/Copyrights — The mention of names of
products in this publication without trademark or copyright
symbols does not imply that they are not so protected by
law. All trademarks are the property of their respective
owners.
Production — Orange Bytes was produced with Adobe In
Design® and Microsoft Word ® using the True Type fonts
Arial, Bodoni and Times New Roman.
Printed by: Creative Technology
5959 Palmer Blvd.
Sarasota, FL 34232—28
800-533-1031

Discounts: 3months=10%, 6=15%, 12=20%
If you are interested in advertising in the publications
of multiple User Groups throughout the region
or nationally, you can learn more
by contacting http://www.apcug.org
Readers, please tell our advertisers that you saw their ad in
the Orange Bytes

QUICK MEMBERSHIP APPLICATION/RENEWAL
Date: ________________
I am a new member
This is a renewal; my membership number is

_______

PLEASE PRINT!
Name _____________________________________________________
Address____________________________________________________
City ______________________________________________________
State_______ Zip _______________ Phone (______) ______-________
email_________________________________________________

Membership Renewal
When you turn in your
Membership Renewal check,
PLEASE fill out a Membership
Renewal Application.
Memberships may also be
renewed on our Website:
https://mmm1427.rapidsite.net/
citivu/noccc/order3.html
Send e-mail address changes
to membership@noccc.org
July 2011

Fees: see page 26 for fee schedule; $35 for single membership.
Since the North Orange County Computer Club is incorporated
as a 501 (c) (3) organization, checks are 100% tax deductible
when made payable to North Orange County Computer Club
.
Amount enclosed $___________________
MC / Visa No. ________________________ Expires ________
Please make your check payable to North Orange County Computer
Club and mail with your application to:

North Orange County Computer Club
PO Box 3616
Orange, CA 92857
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North Orange County Computer Club
PO Box 3616
Orange, CA 92857
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Members: Your expiration month
and year appear on your mailing
label. Please renew promptly,
using the application inside.

Dated Material

Please deliver by July 9, 2011

Are You an NOCCC Member ?
Consider all that you get with membership and Join Now!
• Meetings. Keep up with what’s going on in the computer
world. Hear outstanding industry representatives make presentations of the latest and greatest in computer products.
• Special Interest Groups. Our SIGs cover a broad spectrum
of computer issues. Whether you are a beginner or a power
user, attend the lectures and demonstrations, and share your
knowledge about computers.
• Raffle Drawings. We have distributed thousands of dollars
worth of hardware, software, and books as prizes at our
Main Meeting.
• Consignment Table. We have a consignment table during
even-month meetings, in which members can sell or buy all
kinds of computer & software items.
• Get help with your current computer problems. In the
Random Access portion of the Main Meeting, you may ask
your question of the entire assemblage. More than likely,
someone will have the answer.
• NOCCC Help Line. NOCCC volunteers, experts in their
fields, are ready to assist you with your computer problems.
They can be contacted by email or by telephone.
• The Orange Bytes Newsletter. Our award-winning newsletter reports on club activities and provides articles about
current computer issues and reviews of software and books.
• Product Reviews. Write a review for the Orange Bytes and
keep the software, hardware, book, or CD!
• Volunteer Work. We have numerous interesting assignments available. As an all-volunteer organization, you can
join with other members in a variety of activities: solicit
newsletter ads, write articles for our newsletter, conduct
a seminar, run a SIG, give a Main Meeting presentation,
show new members around, join a committee, assist in
setting up the meeting or participate in computer-related
community volunteer work.
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Become an NOCCC member by signing up at the Reviews/
Membership Desk during a general meeting, usually the first
Sunday of the month. Or simply fill out the form on the reverse
side of this page and send it in.
Meeting Information — The NOCCC meeting is held at Chapman University, in the Hashinger Science Center and Irvine
Hall, near the northwest corner of N. Center St. and E. Palm
Ave.
Parking Information - Chapman University’s main parking lot
is the underground Lastinger Parking Structure under Wilson
field on the north side of the campus. Enter from Walnut Avenue, just east of Glassell Street. Parking is not free on Sunday,
even if the gate is up. However, the permit vending machine
is about 100 feet south of the entry area. There are other
machines elsewhere in the lot. Find one, buy a permit, and put
it on your dashboard. Do not park in any other lot, in a reserved
space, or back into a space.
Free street parking also is available on the campus-side of the
streets only. Parking in front of any residential housing will
result in an expensive parking ticket. A City of Orange public
parking lot, located on the southwest corner of E. Maple and
N. Orange, is also free and only 2 blocks from the meeting. For
more information, see the Transportation Information section.

Orange Bytes

